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	Evolution of Computers

Exercise

A.	 1.	a	 2. c	 3. c	 4. a

B.	 1.	Charles Babbage	 2. Lady Ada Lovelace	

	 3. John Mauchly		  4. IBM

C.	 1.	1642	 2. 1946	 3. 1944	 4. 1985

D.	 1. �In ancient times, people calculate or count with the help of fingers, toes, pebbles, stones, 
sticks and bones.

	 2.	In fourth generation of computers microprocessors were used.

	 3. 	�ENIAC was the first general purpose electronic computer built by John Mauchly and Presper 
Eckert in 1946.

E.	 1.	�The first generation computers were made up of vacuum tubes whereas second generation 
computers were made up of transistors. 

	 	 Second generation computers were less expensive than the first generation.

	 2.	Two features of third generation computers are:

	 	 (i) Third generation computers used IC’s (Integrated Circuits). 

	 	 (ii) They were more affordable and dependable.

F.	 Third Generation
In the lab

Do yourself.

1.

IMPRINT 1
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	Working with Windows 10

Exercise

A.	 1.	a	 2. a	 3. c	 4. c
B.	 1.	Video file	 2. Music file	 3. Image file	 4. Spreadsheet file
C.	 1.	T	 2. T	 3. T	 4. T
D.	 1.	�Name of the common folders provided by Windows 10 are Documents, Videos, Pictures, 

Music and Downloads.
	 2.	Organised files and folders help us find the right files to use when we run a program.
E.	 1.	�A folder is a collection of various files and sub folders whereas a file is a collection of related 

information.
	 2.	To delete a file or folder, follow the given steps: 
	 	 Step 1	 Open the folder that contains the file you want to delete. 
	 	 Step 2	 Right-click on File or folder. 
	 	 Step 3	 Click on Delete option.

In the lab

Do yourself.

Periodic Assessment 1
(Based on chapters 1 & 2)

A.	 1.	Analytical Engine 	 2. ENIAC		
	 3. Pascaline adding machine	 4. Tabulating Machine	 5. Step Reckoner
B.	

Search barAddress barForward

Toolbar

Back

Navigation 
Pane

C.	 1.	Video file 	 2. Transistor	 3. Pascaline	 4. Folder

2.
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	�Page Formatting and Mail Merge in Word 2016

Exercise

A.	 1. a 	 2. b 	 3. a 	 4. a 	 5. c

B.	 1. Indentation 	 2. Bottom 	 3. Tabs 	 4. Breaks

C.	 1. The components of Mail Merge are: Main Document, Data Source and Merged Document. 

	 2. There are two types of orientations in Word 2016: Portrait and Landscape.

D.	 1. To insert Header in a Document, follow these steps: 

	 	 Step 1:	 Click on Insert tab. 

	 	 Step 2:	 Click on the Header or Footer command. 

	 	 Step 3:	� You can choose from various available header/footer templates or choose Blank 
option to enter text of your choice. 

	 2. (This question was printed incorrectly in the book, Please correct it in your textbook) 

		  Q. Write the steps involved in creating New Address List in mail merge.

	 	 Ans. To create New Address List in mail merge, follow these steps:

	 	 Step 1:	� Click on Select Recipients command in the Start Mail Merge group under Mailings 
tab.

	 	 Step 2:	� Select the Type New List option from the drop-down list. The New Address List 
dialog box will appear.

	 	 Step 3:	� Enter required details like Title, First Name, Last Name, Address Lines, etc. for all 
the recipients. when the details of all the recipients have been added, click on OK 
button.

	 	 Step 4:	� This will open Save Address List dialog box. Enter a name for  the file and click on 
Save button.

In the lab

Do yourself.

3.
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B.	 	 Enhancing a Presentation 

Exercise

A.	 1. c	 2. b	 3. a	 4. c	 5. a

B.	 1.	Design	 2. Justify	 3. Insert	 4. Chart Layouts

C.	 1. �Slide Master is used to create the default layout and appearance of the slides in the 
presentation. 

	 2. �A theme is a set of predefined layouts that can be used to add a professional touch to your 
presentations. 

	 3. �A chart is an important part of PowerPoint to display data in pictorial form. It makes it easier 
to draw comparison and analyse the growth, relationship and trends among the values in a 
table. 

D.	 1. To insert a table in a slide, follow these steps: 

	 	 Step 1	 �Create a new presentation or open an existing presentation and select the slide 
on which you want to insert a table. 

	 	 Step 2	 �Click on Table command from the Tables group under the Insert tab.  
A drop-down menu appears.

	 	 Step 3	� Hover the mouse over the square boxes and click on the last box up to which you 
want to insert the table. 

	 	 The table with selected rows and columns will be inserted. 

	 2.	�To insert a chart in a slide, follow these steps: 

		  Step 1	� Select the slide on which you want to add a chart. Click on the Chart command 
under the Illustrations group of the Insert tab. The Insert Chart dialog box 
appears. 

		  Step 2	 Select the type of chart from the left pane and chart format from the right pane

		  Step 3	 Click on OK button.

	 3. Theme Background is a background style of the theme. 

		  To change Theme Background, follow these steps:

	 	 Step 1	� Click the Background Styles command under the More button of the Variants 
group, on the Design tab of the ribbon. 

4.
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	 	 Step 2	� Place your mouse pointer over any of the background styles. The background 
style will be reflected on the slide for you to evaluate. 

	 	 Step 3	 Click when you find a background style that you like.

E.	 Design Tab
In the lab

Do yourself.

Periodic Assessment 2
(Based on chapters 3 & 4)

A.	

Legend

X-axis

Y-axis

Grid lines

Data Labels

Data Series

Plot Area

Chart Title

B.	 1.	e 	 2. d 	 3. a	 4. b	 5. c

Test Sheet 1
(Based on chapters 1 to 4)

Section A

A.	 1. (iii)	 2. (ii)	 3. (i)	 4. (ii)	 5. (i)

	 6. (iii)	 7. (ii)	 8. (i)

B.	 1. IBM	 2. Folder	 3. Sub folder	 4. Design 	 5. Indentation

C.	 1. T	 2. T	 3. T	 4. T

Section B

A.	 1.	Fourth generation computers

	 2. 	�A theme is a set of predefined layout that can be used to add a professional touch to your 
presentations.
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	 3. 	Organised files and folders help us find the right files to use when running a program.

	 4. 	There are three main components of Mail Merge, which are as follow:

		  Main Document, Data Source and Merged Document.

B.	 1.	�To delete a file or folder, follow these steps:

	 	 Step 1:	 Open the folder that contains the file you want to delete. 

		  Step 2:	� Right-click on the contains the file you want to delete. A drop-down menu 
appears.

		  Step 3:	 Click on Delete option.

	 2.	�To insert a chart in a slide, follow these steps:

	 	 Step 1	� Select the slide on which you want to add a chart and click on the Chart 
command under the Illustrations group of the Insert tab. The Insert Chart dialog 
box appears.

	 	 Step 2	� Select the type of chart from the left pane and chart format from the right pane.

	 	 Step 3	 Click on OK button.

	 3. (This question was printed incorrectly in the book, Please correct it in your textbook) 

		  Q. Write the steps involved in creating New Address List in mail merge.

	 Ans. To create New Address List in mail merge, follow these steps:

	 	 Step 1:	 �Click on Select Recipients command in the Start Mail Merge group under Mailings 
tab.

	 	 Step 2:	� Select the Type New List option from the drop-down list. The New Address List 
dialog box will appear.

	 	 Step 3:	 �Enter required details like Title, First Name, Last Name, Address Lines, etc. for all 
the recipients. when the details of all the recipients have been added, click on OK 
button.

	 	 Step 4:	� This will open Save Address List dialog box. Enter a name for  the file and click on 
Save button.

	Introduction to Excel 2016

Exercise

A.	 1. a	 2. a	 3. c	 4. b

B.	 1.	T	 2. F	 3. T	 4. T

5.
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C.	 1. Excel 2016	 2. create	 3. formula	 4. 1048576

D.	 1.	Spreadsheet is a program that allows you to store and analyse numerical data.

	 2.	 �The horizontal divisions on a worksheet are called rows and vertical divisions on a worksheet 
are called columns.

	 3.	�16, 384 columns.

E.	 1.	�The data in the form of numbers or text can be entered by just clicking on a cell and typing 
with the help of a keyboard. You can type data directly into the cell, or you can enter data 
using the Formula bar.

	 2.	�Any three components of  the Excel window are:

	 	 (i) �File Tab: A green button located at the left top corner that contains the file menu commands 
such as New, Open, Save, etc. 

		  (ii) Ribbon: This bar has tabs with group of related commands displayed on it. 

		  (iii) Name Box: The address of the active cell is displayed in this box.

	 3.	 �In Excel, there are three different types of data. These are- Labels, Values or Numbers and 
Formula.

	 	� Formula: A formula is a mathematical expression used to do simple and complex calculations 
of the numeric data inserted in a cell or a range of cells. A formula always begins with an 
equal to (=) sign e.g. = A2 + B2.

F. 	 �He will use Save command. 
In the lab

Do yourself.

	Editing in Excel 2016

Exercise

A.	 1. a	 2. a 	 3. b 	 4. c

B. 	 1. Insert 	 2. Unmerge cells 	 3. Select all 	 4. Merge & Center 

C.	 1. F 	 2. F	 3. F 	 4. T 

D.	 1.	Yes, we can unmerge the merged cells by using Unmerge Cells option.

	 2.	Copy command is used to copy the content at new place and also exist its original place.

	 3.	The default column width is 0 to 255 and a row height is 0 to 409.

6.
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E.	 1. To merge cells, follow these steps: 

	 	 Step 1	 Select two or more adjacent cells that you want to merge. 

	 	 Step 2	 Click on Merge & Center command in the Alignment group on Home tab.

		�  The cells will be merged in a row or column, and the cell content will be centered in the 
merged cell.

	 2.	To change the row height and column width, follow these steps:

	 	 Step 1	 Select the column(s) or row(s) whose width or height you want to change. 

	 	 Step 2	 Click on Format command in Cells group from Home tab. 

	 	 Step 3	 �Choose Column Width or Row Heights under Cell Size section from the drop-down list.

		  A Column width or Row height dialog box will appear.

	 	 Step 4	� In the Column Width or Row Height box, type the value that you want your 
column or row to be. 

	 3.	To rename a worksheet tab, follow these steps:

	 	 Step 1:	 On the Worksheet tab right-click the sheet tab that you want to customize.

		  Step 2: Click Rename to rename the sheet.

		�  Type the name you would like for your spreadsheet. The information will be added to the 
tab at the bottom of the spreadsheet.

F. 	 �She can set the column width and row height using Format command in Cells group from 
Home tab.

In the lab

Do yourself.

Periodic Assessment 3
(Based on chapters 5 & 6)

A.	 1.	Workbook

	 2.	(This question was printed incorrectly in the book, Please correct it in your textbook)

	 	 Q. It displays the address of the active cell 

	 	 Ans. Name box

	 3.	Autofill
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B.	

Components of Excel 2016

Quick Access Toolbar Title Bar Control buttons

Formula 
bar

Name box

Active Cell

Worksheet Tab

Status 
bar

Mouse Pointer

C.	 Excel 2016.

	Internet and E-Mail 

Exercise

A.	 1. a	 2. a	 3. c	 4. c 

	 5. b	 6. b

B.	 1. F	 2. F	 3. F	 4. T 

	 5. T	 6. F

C.	 1. Bcc	 2. To	 3. Cc	 4. Attachment	 5. Sent
D.	 1.	�Internet is a network in which millions of computers are connected to one another to share 

information.
	 2.	�Emoticons are used to represent your facial expressions. They help in telling your mood to 

others as well as save typing time.
	 3.	Yes, we can send a video file as attachment in an e-mail.
	 4.	�An E-mail or electronic mail can be defined as the process of exchanging messages 

electronically through a communications network by using computer.
E.	 1. �‘Signing in or Sign in’ is the process of accessing your e-mail account by providing the user 

name and password. You can access your e-mail account anytime by using www.gmail.com. 

7.



Play (Ver. 2.0)-V (Answer Key)10

	 2.	Advantages of E-mail are: 
	 	 (i)	 An e-mail can be sent anytime and from anywhere in the world. 
	 	 (ii)	 An e-mail can be sent to many people at a time. 
	 	 (iii)	 An e-mail can be easily forwarded to anyone without typing it again.
	 3. Features of E-mail are: 
	 	 (i)	 Ability to attach the files along the message 
	 	 (ii)	 Ability to store the information such as message and contact list 
	 	 (iii)	 Ability to send Multipurpose Internet Mail Extensions (MIME) type files.
F.	 He should use Bcc feature.

In the lab

Do yourself.

DATA PROCESSING

A.	

2.

3.

4.

5.

1. 8  5  12  12  15       

12  15  7  15       

4  1  20  1       

4  22  4       

13  15  21  19  5        

H

L

D V D

M

D A T A

O U S E

O G O

E L L O
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B.	
Name of the Item Number of the Item

1.	 Shuttle Cock 7

2.  Football 5

3.	 Chair 4

4.	 Table 3

5.	 Hockey Stick 5

	

Name of the Item Number of the Item

1.	 Shuttle Cock 7

2.	 Football 5

3.	 Hockey Stick 5

4.	 Chair 4

5.	 Table 3

	Creating Shapes in Scratch 

Exercise

A.	 1. a	 2. c 	 3. c 	 4. b 
B.	 1. F 	 2. F 	 3. T	 4. T
C. 	 1. Pen block draws a trail as the Sprite moves on the stage. 

8.



Play (Ver. 2.0)-V (Answer Key)12

	 2. Steps to draws a line in Scratch: 

	 	
D.	 1.	Polygons are 2D shapes with three or more straight lines and angles. 
	 	 Three polygon shapes are triangle, square and pentagon. 
	 2.	�The main difference between drawing a square and a rectangle in Scratch is the number of 

steps used in script. In square we use Repeat 4 Move 100 Steps Turn 90 degrees whereas in 
rectangle we use Repeat 4 Move 200 Steps Turn 90 degrees Move 100 Steps Turn 90 degrees.

E. 	 1.	 Sides 1 
	 	 Degree 360 
	 2.	 Sides 4 
	 	 Degree 90 
	 3.	 Sides 5 

	 	 Degree 72 

Do yourself

Hands-On

In the lab

Do yourself.

	Creating A Game in Scratch 

Exercise

A.	 1. a	 2. b 	 3. a 	 4. b 
B.	 1. Hat	 2. Sensing	 3. Variables	 4. Ask 
C. 	 1. T	 2. T	 3. F	 4. F 

9.
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D.	 1. Hat blocks, Stack blocks and Boolean block. 
	 2. �Sensing blocks in Scratch sense the input from the keyboard or the mouse at the time of 

execution of a script. 
E. 	 1. �Variable is an element that stores all the numbers, text, date or pictures that we use in a 

program. 

	 	 To create variables in Scratch, follow these steps: 

	 	 Step 1	 Click on Variables block category. A set of blocks appears in the block palette.

	 	 Step 2	� Click on Make a Variable block. A New Variable dialog box appears. Type a 
variable name in the New variable name box. 

	 	 Step 3	 �Click on the radio button of either of the options. Click on For all sprites if you 
want this variable to appear for all the sprites. 

	 	 	 Or 

	 	 	 �Click on For this sprite only if you want this variable to appear all the sprites only. 

	 	 Step 4	 Click Ok button. 
	 2.	Scratch has two conditional blocks. They are: 
		  a. �If…then block: In this block if the condition is true, the blocks inside conditional block will 

run. If the condition is false, the blocks inside conditional block will not run. Only the blocks 
outside the conditional block will run. 

		  b. �If…then…..else block:  In this block if the condition is true, the blocks inside then condition 
will run. If the condition is false, the blocks inside else condition will run.

	 3.	To add sensing blocks to the script, follow these steps: 

	 	 Step 1	 Click on the Sensing block category in Tabs. 

	 	 Step 2	 Insert a sprite, Penguin2 on the stage. Delete the cat sprite. 

	 	 Step 3	 Add a new backdrop to the stage, Arctic. 

	 	 Step 4	� Now drag the ask block to the script area. Click on the block. A speech bubble 
appears above the penguin with the text, “What’s your name?”. 

		�  You will also see an input box on the stage with a blinking cursor. Type your name. It will 
appear in the input box. Click on the tick button or press the Enter key. You will notice that 
the input box waits for your input.

		  Also, when you type the name and press Enter key, the name disappears.

	 	 Step 5	� To display the typed name also, click on the check box before the answer block. 
The answer appears on the stage.conditions.
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F.	 (This question was printed incorrectly in the book, Please correct it in your textbook.)
	 Q. �Parth is creating a game in Scratch. He need to do a task which is dependent on some 

condition in the game. Which blocks will he use to do so?

	 Ans. He will use conditional blocks in the game.

Do yourself

Hands-On

In the lab

Do yourself.

Periodic Assessment 4
(Based on chapters 7 & 9)

A.	 1. This block is used to repeat a set of statements until a condition becomes false. 
	 2. This block is used to repeat a set of blocks infinitely. 
	 3. This block sets the value of a variable. 
B.	 1. d 	 2. c	 3. a 	 4. b
C.	

Test Sheet 2
(Based on chapters 5 to 9)

Section A

A.	 1. (i)	 2. (i)	 3. (ii) 	 4. (iii)	 5. (iii) 
	 6. (iii) 	 7. (ii) 	 8. (ii)
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B.	 1. Create	 2. Unmerge Cells	 3. Cc	 4. Attachment	 5. Ask
C.	 1.T	 2.T	 3.T	 4.F	 5.F
	 6.T	 7.F	 8.T

Section B

A.	 1. �Sensing blocks in Scratch sense the input from the keyboard or the mouse at the time of 
execution of a script.

	 2. Pen block draws a trail as the Sprite moves on the stage. 

	 3. �Emoticons are used to represent your facial expressions. They help in telling your mood to 
others as well as save typing time. 

	 4. Copy command is used to copy the content at new place and also exist its original place.

B.	 1. Scratch has two conditional blocks. They are:
	 	 a. �If…then block: In this block if the condition is true, the blocks inside conditional block 

will run. If the condition is false, the blocks inside conditional block will not run. Only the 
blocks outside the conditional block will run.

	 	 b. �If…then…..else block: In this block if the condition is true, the blocks inside then 
condition will run. If the condition is false, the blocks inside else condition will run.

	 2.	�The main difference between drawing a square and a rectangle in Scratch is the number of 
steps used in script. In square we use Repeat 4 Move 100 Steps Turn 90 degrees whereas 
in rectangle we use Repeat 4 Move 200 Steps Turn 90 degrees Move 100 Steps Turn 90 
degrees. 

	 3.	To change the row height and column width, follow these steps:
	 	 Step 1:	 Select the column(s) or row(s) whose width or height you want to change. 

	 	 Step 2:	 Click on Format command in Cells group from Home tab. 

	 	 Step 3:	  �Choose Column Width or Row Height under Cell Size section from the drop-
down list.

	 	 A Column width or Row height dialog box will appear.
	 	 Step 4:	� In the Column Width or Row Height box, type the value that you want your 

column or row to be.

	 4.	Any three components of the Excel window are:
	 	 (i)	� File Tab: A green button located at the left top corner that contains the file menu 

commands such as New, Open, Save, etc. 
	 	 (ii)	 Ribbon: This bar has tabs with group of related commands displayed on it. 
	 	 (iii)	 Name Box: The address of the active cell is displayed in this box.




